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CHAPTER 1

Introduction
Following are the new features in this release of Flare.

For more information about each feature discussed in this manual, open the online Help and refer to
the "What's New" topic. Links are provided in some feature descriptions, taking you to topics that
contain additional information and steps.

Feature What's New?

"Analytics on MadCap Central" on page 7 n Obtain information about how people are using
your HTML5 output

n Works with output hosted on Central or on your
own server

n Create analytics keys in Flare or on Central

"Publishing Directly to MadCap Central"
on page 18

n Destination file created automatically

n Use command line to publish to Central

"Confluence Import" on page 23 n Import Confluence pages into a new project or
an existing one

n Works with both cloud and local versions of Con-
fluence

"Responsive Conditions" on page 32 n Set conditions by media query (Web, Tablet,
Mobile)

n Supported in HTML5 targets
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Feature What's New?

"Word Import Enhancements" on page 48 n New wizard structure

n More intuitive

n Additional features for styles, tables, lists, and
page breaks

"Additional Features" on page 72 n Accessibility enhancements

n DOCX default Word format

n Drag and drop files into Flare

n FrameMaker 2019 support

n Git for Windows integration

n Zendesk publishing enhancements

"Deprecated Features" on page 102 n List of features that will be deprecated in this
release

n Recommended replacements for deprecated
features
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CHAPTER 2

Analytics on MadCap Central
If you have a MadCap Central license, you can view analytics on published Flare HTML5 output. This
includes search phrases used, search phrases with no results, topics viewed, context-sensitive Help
calls, and demographic statistics (browsers and operating systems).

To create and manage keys, you must have the following permission setting in Central:

However, all users on the license can view analytics data, regardless of their permission settings.

For more information about permissions, see the Central online Help.

This chapter discusses the following:

Types of Analytics Information 8

Host Output Anywhere 14

Creating and Editing Analytics Keys 15

Associating Analytics KeysWith Targets 16

Managing Analytics Keys 17
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Types of Analytics Information
By using Central Analytics, you can obtain the following information about your output:

n Search

l Phrases Shows all search queries made to the output, including whether a search term
returned any micro content results. This is useful because it indicates the kind of doc-
umentation most often sought by users, as well as whether you should create new micro
content to match certain search terms.
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l Phrases with No Results Shows all search phrases that didn't produce any results. This is
useful because it indicates if you need to produce new documentation to provide results for
users, or perhaps create synonyms that will show results for existing documentation.
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n Content

l Topics Shows all topics in the output that have been viewed at least once. This is useful
because it indicates the topics where you might want to focus much of your attention.
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l Context-Sensitive Help Calls This shows context-sensitive Help identifiers that have been
invoked at least once in the output. This is useful because it indicates which areas of your
product’s interface are most active, and perhaps even unclear to users.
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n Demographics

l Browser Statistics Shows which browsers are being used to view your online output. The
graph shows a broad view of the browsers, and the grid breaks down the information into
specific browser versions. This is useful because it indicates which browsers you should
focus on supporting.
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l Operating System Statistics Shows which operating systems are being used to view your
online output. This is useful because it indicates which operating systems you should
focus on supporting. It might even be used to determine whether your company’s software
needs to continue supporting certain operating systems.

NOTE The graph at the top is limited to the first 10 items. The grid below shows all items.

NOTE For more information about using the Analytics page—including downloading and fil-
tering data—see the Central online Help.
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Host Output Anywhere
Central Analytics works on Flare projects uploaded to Central, or you can host output on your own
servers. If you host the output outside of Central, you still need to use Central with a key to view the
analytics data. Also, the server where you host the output must not be locked down, but rather able
to communicate with Central.
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Creating and Editing Analytics Keys
Analytics keys are associated with Flare HTML5 targets. You can create and edit these keys either
in Flare or on Central. To do this, you must have the permission on Central to “Manage Output Ana-
lytics Keys” (see the Central online Help).

HOW TO CREATE OR EDIT AN ANALYTICS KEY IN FLARE

1. Open an HTML5 target.

2. Select the Analytics tab.

3. From the Provider field, select Central.

4. If you are not yet logged in to Central, click Login. Then complete the fields in the dialog and
click OK.

5. From the Central License field, choose your license.

6. Next to the Key field, click Create.

If you already have a key that you want to edit, select it from the drop-down, then click Edit.

7. Enter a name for the key and an optional description, then click OK.

8. Click to save your work.
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Associating Analytics Keys With Targets
If you create a key in Flare, it will become associated with your target as you do this. But if you cre-
ate the key in Central, you need to then open the Flare target and associate that key with the target.

HOW TO ASSOCIATE AN ANALYTICS KEY WITH A TARGET

1. Open an HTML5 target.

2. Select the Analytics tab.

3. From the Provider field, select Central.

4. If you are not yet logged in to Central, click Login. Then complete the fields in the dialog and
click OK.

5. From the Central License field, choose your license.

6. At the bottom of the Key area, click the drop-down and select the name of the key.

7. Click to save your work.
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Managing Analytics Keys
You can also click Manage Keys in the Flare target.

This opens the Analytics page in Central. From here, you can create and edit keys, as well as delete
any that you no longer need.

NOTE If the project is not bound to Central, you can view the analytics information on any
Central license where you are using the analytics key. However, if the project is bound to
Central, you can view its analytics only on the Central license where the project is uploaded.

NOTE As a result of this new feature, the Community tab in the Target Editor has been
renamed “Analytics.”
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CHAPTER 3

Publishing Directly to MadCap
Central
Previously, to get generated Flare output on MadCap Central, you needed to upload the project and
build a target on Central itself. You can still do that, but you also now have the option of publishing
output directly to Central from the local Flare project. By “publish,” we mean copying your output
files to Central, not making that output “Live,” which would make it visible to the general public. You
would still need to use Central to make that output Live.

Also, you must be associated with the project on Central and have the “Run/Schedule Build” per-
mission. See the Central online Help.

This chapter discusses the following:

How to Publish Directly to Central 19

Command Line 21
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How to Publish Directly to Central
1. If it is not already done, upload a Flare project to Central.

2. Open an HTML5 target.

3. Select the Publishing tab.

4. Next to the Central destination, click the Publish check box.

NOTE This destination is automatically shown on the tab if the project is bound to
Central. If it is not bound to Central, you will not see this destination.

5. Click to save your work.

6. At the top of the editor, click Build.

7. When the build finishes successfully, click Publish.

After the target publishes, you can see the result in Central. A Flare icon displays next to
builds that originated from Flare. A Central icon displays next to builds that originated from
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Central.
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Command Line
You can also use the command line for this feature. Notice that you need to include your email and
Central password in the command.

HOW TO USE THE COMMAND LINE TO PUBLISH DIRECTLY TO CENTRAL

1. Open Notepad (to create and save a batch file) or open your command prompt (to run a com-
mand immediately).

2. Type the path to the Flare.app folder where you installed Flare, and press Enter.

cd\Program Files\MadCap Software\MadCap Flare 15\Flare.app

3. Type the following and press Enter on your keyboard (entering the correct information in
place of the sections in square brackets):

madbuild -project [project] -centralUsername [email address]
-centralPassword [password] -target [target]

NOTE If there are spaces anywhere in your path or project name, you need to use
quotation marks around it.

EXAMPLE

Your email address is bsmith@fictionsoft.com, and your Central password is R!f-
fraff22. You have a project called "FictionSoftPro" that you have stored in a folder
of the same name at the root level of the C: drive. If you want to publish the tar-
get named "Beginner" to Central, you can type this:

madbuild -project c:\fictionsoftpro\fictionsoftpro.flprj
-centralUsername bsmith@fictionsoft.com -centralPassword
R!ffraff22 -target Beginner
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EXAMPLE

If the project is located in a folder called "my projects,” and the target is named
"Beginner Online Help" (with spaces between words), you would type this:

madbuild -project "c:\my projects\fictionsoftpro.flprj"
-centralUsername bsmith@fictionsoft.com -centralPassword
R!ffraff22 -target "Beginner Online Help"

NOTE After the project is bound to Central (along with any targets you plan to publish), it is
not technically necessary to synchronize changes with Central to have the latest files
included in a build that is initiated locally. However, you would need to continue syn-
chronizing in order to see the latest files on Central when using other features (e.g., check-
lists, builds initiated from Central).

NOTE MadCap Search and Elasticsearch are supported with this feature. Google Search is
not supported.

NOTE Build events are supported when publishing directly to Central. However, when build-
ing from Central itself, build events are not supported.
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CHAPTER 4

Confluence Import
If you have an Atlassian Confluence account, you can import pages (HTM and resource files) into
Flare projects. You can import these files into a new Flare project or an existing one. Flare supports
both the cloud and local versions of Confluence.

This chapter discusses the following:

How to Import Confluence Pages 24

How Elements are Converted From Confluence to Flare 27
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How to Import Confluence Pages
1. Do the following, depending on how you are importing your files:

IMPORT INTO A NEW PROJECT

a. Select Project > Import > Confluence Pages.

b. Select Import into a new project.

c. In the Project name field, type a name for the new Flare project that will be created
after you perform the import.

d. In the Project folder field, either accept the default location for the new project or click
to find and select a folder.

e. From the Output type field, select the primary target for your project. You can always
change this later, after the project is created.

IMPORT INTO AN EXISTING PROJECT (WIZARD)

a. Select Project > Import > Confluence Pages.

b. Select Import into this project.

c. (Optional) Click and select a folder in the Content Explorer to hold the imported
files. If you do not select a folder, the files will be placed at the root level of the Content
Explorer.

IMPORT INTO AN EXISTING PROJECT (IMPORT EDITOR)

If you do not yet have a Confluence import file:

a. Complete the steps for adding an import file.

b. Open the file in the Confluence Import Editor.

If you already have a Confluence import file:

a. In the Project Organizer, expand the Imports subfolder.

b. Double-click the appropriate import file. The file opens in the Confluence Import Editor
to the right.

2. Complete the Confluence Server, Username, and Password fields. Then click Submit. The
Workspace Selection page should open automatically.
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3. From the drop-down, select the space from which you want to import.

4. In the tree, select the pages to be imported. If you click on an item, a preview for it displays to
the right.
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5. (Optional) On the left, select Advanced Options and choose the following options as neces-
sary:

TOPICS

n Import linked pages Select this if you want to automatically bring in other files that are
linked to those you selected from the tree. For example, if you choose to import a page
called “Beer,” which contains a link to a page called “Food,” this option imports both
pages.

n Remove inline formatting Select this if you do not want to keep any inline formatting in
the pages. If you do not select this option, the formatting will be retained. However,
keep in mind that styles, rather than inline (local) formatting, is recommended in Flare
projects.

n Remove style classes Select this if you want to remove any style classes that Con-
fluence might have added to elements (such as tables and images). Otherwise, you
might have some undefined styles after the pages are imported into Flare.

RESOURCES

n Import resources Select this option if you want to include any supporting resource files
(e.g., images, multimedia) in the import. In Flare, these will be added to the Resources
folder in the Content Explorer, and they will link to the appropriate topics.

REIMPORT

n Link generated files to source files Select this option if you want to continue editing in
Confluence and re-import as needed. Deselect it if you want to edit the imported files in
Flare going forward.

6. Do one of the following, depending on the part of the interface you are using:

n Wizard Click Finish. The Accept Imported Documents dialog opens. The files that will be
created as a result of the import are listed on the left. A preview of each file can be seen
to the right when you click the file.

n Import Editor In the local toolbar click Import (if this is the first time importing files) or
Reimport (if files have been imported previously). The Accept Imported Documents dia-
log opens. The files that will be created as a result of the import are listed on the left. A
preview of each file can be seen to the right when you click the file.

7. When you are finished previewing the files to be created, click Accept.
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How Elements are Converted From
Confluence to Flare
Certain elements from Confluence are converted to their closest counterparts in Flare. The fol-
lowing table describes this.

Confluence Flare

Paragraph Styles

Article title H1

Heading 1 through Heading 6 H1 through H6

Preformatted Text surrounded by <pre> tags

Quote Text surrounded by <blockquote> tags

Character Styles

Bold Text surrounded by <strong> tags

Font color Text surrounded by <span> tags

Italic Text surrounded by <em> tags

Monospace Text surrounded by <code> tags

Strikethrough Text surrounded by <s> tags

Subscript Text surrounded by <sub> tags

Superscript Text surrounded by <sup> tags

Underline Text surrounded by <u> tags

Lists

Bulleted list Bullet list

Numbered list Numbered list

Task list Bullet list
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Confluence Flare

Alignment

Center Center

Left Left

Indent Indent

Outdent Outdent

Right Right

Content

Date Text

Emoticon SVG image

Gallery Table containing images

Horizontal rule Horizontal rule

Info Text surrounded by <div> tags

Link Link

Markup Text

Status Text surrounded by <div> tags

Symbol Symbol

Table of contents Links in bulleted list

Task list Bulleted list

User mention Link

Other Macros

Blog post Text surrounded by <div> tags

Change history Links in table
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Confluence Flare

Content by label Text surrounded by <div> tags

Content by user Links in table

Content report table Text in table

Contributor Link

Contributor summary Text and links in table

Create from template Link

Except include Text

Favorite pages Text and links

Include pages Text

Labels list Links

Microsoft Office Excel File added to Content Explorer

Microsoft Office PowerPoint File added to Content Explorer

Microsoft Office Word File added to Content Explorer

Multimedia Multimedia file with image as placeholder

PDF File added to Content Explorer

Popular labels Links in bulleted list

Recently updated Links and text

Recently updated dashboard Links

Related labels Text

Space attachments Links and text in table

Space details Text

Spaces list Links in table
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Confluence Flare

Status Text

Task report Text and links in table

User profile Links

Formatting

Code block Text surrounded by <div> tags

Column Text surrounded by <div> tags

Expand Text surrounded by <div> tags

Info Text surrounded by <div> tags

No format Text surrounded by <div> tags

Note Text surrounded by <div> tags

Panel Text surrounded by <div> tags

Section Text surrounded by <div> tags

Tip Text surrounded by <div> tags

Warning Text surrounded by <div> tags

Navigation

Children display Link

Livesearch Search bar in output

Page index Link in table

Search results Text and links

Table of content zone Text

Table of contents Links
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Confluence Flare

Reporting

Global reports Links and text in table

Page properties Text

Page properties report Text in table

Popular labels Links

NOTE If you import a GIF image using the GIPHY integration in Confluence, the file will be
imported without an extension and will resemble a folder in the Content Explorer.
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CHAPTER 5

Responsive Conditions
For HTML5 targets, conditions can be used to make content responsive (e.g., content changes auto-
matically according to the size of the screen, rather than simply based on “include” or “exclude”).
Associating conditions with factory media queries (Web, Tablet, Mobile) can help make some con-
tent more appropriate or easier to read on different devices.

This chapter discusses the following:

Features and User Interface Areas Affected 33

Limitations 34

How to Set Conditions by Media Query 35
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Features and User Interface Areas Affected
In addition to using this feature in targets, it can also be accessed when working in other areas of
the user interface. Following are the features for which you can and cannot set conditions to display
by media query.

Can Set by Media Query Cannot Set by Media Query

Target Editor Export Project Wizard

XML Editor Snippet Conditions

Preview Import Flare Project Wizard and Editor

Review Wizard
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Limitations
Keep the following in mind if you intend to display conditioned content according to media queries:

n This feature does not support all outputs. It works only for HTML5 targets.

n Only factorymedia queries (Web, Tablet, Mobile) are supported and are controlled by the
breakpoints specified in the skin or target. This feature does not support custom media quer-
ies.

n Only conditions applied to content are supported. This feature does not support conditions
that are applied to folders and files.
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How to Set Conditions by Media Query
Following are steps for setting conditions by media query in the Target Editor. The steps are similar
if you are working in the XML Editor, Preview window, or Send Files for Review Wizard; the first few
steps would vary, depending on the part of the user interface (for links to each full set of steps, see
"Features and User Interface Areas Affected" on page 33).

1. Open the HTML5 target.

2. Click the Conditional Text tab.

3. Toward the bottom of the tab, make sure the Basic option is selected.

4. In the Condition Tag Sets area, you can choose to view tags for all condition tag sets or you
can select a specific set. The tags associated with the selected set are shown to the right,
with their associated colors. An Action cell appears next to each condition tag. When Basic is
selected, the Action cell is shown and the Advanced section below is disabled. In the Tags
area, select a condition tag in the grid to set its action. (You can also hold down the SHIFT or
CTRL key and choose multiple rows to set the same action on all of them at once.)
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5. The Action cell in the grid indicates the current setting for the condition. The text is gray if you
have not explicitly chosen an option. To change the setting, choose one of the options in the
area to the right.

n Not Set If an action is not set on a condition, its behavior may vary (i.e., it might be
included or excluded). This depends on whether or how you have set other conditions.
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n Include Select this if you want the content associated with the condition to always dis-
play in the target’s output.
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n Exclude Select this if you want the content associated with the condition to never dis-
play in the target’s output.
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n Display by Media Query Select this if you want the content associated with the con-
dition to display only when the user is viewing the output on a particular screen size
(according to the responsive output breakpoints that are set in the target or skin). After
selecting this option, choose one or more of the media query check boxes. The Active
cell in the grid updates accordingly.

l Web The content will display if the user is viewing it on a large screen.
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l Tablet The content will display if the user is viewing it on a medium screen, such as
an iPad.

l Mobile The content will display if the user is viewing it on a small screen, such as an
iPhone.
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NOTE If you select all three of the media query check boxes, it has the same effect
as choosing the “Include” option.

NOTE The “Display by Media Query” option is not available unless you are working in
an HTML5 target. Other target types do not show this option.

NOTE The Basic method is the easiest way to display conditions by media query.
However, you can also use the Advanced method. If you choose to do so, the markup
should look something like the following.

6. Click to save your work.
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EXAMPLE

You are writing documentation for a cloud-based product, where it is more appropriate
to tell users to “click” an option if they are working on a large screen, but to “tap” the
option if they are using a tablet or smart phone.

So in a condition tag set, you create three new conditions—one for each of those
screen sizes.

You write a procedure where you need to use to tell users to click or tap something.
Therefore, you add both words to the instructions.
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Then you apply the condition you named “Web” to the word “click,” and you apply the
“Tablet” and “Mobile” conditions to the word “tap.”
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You anticipate that you will need to use these words many times throughout the pro-
ject, so you create snippets—one holding the uppercase pair of words, and the other
holding the lowercase pair. That way, you can just insert the appropriate snippet
wherever those words are needed, rather than applying the conditions to text each
time.

Next, you open the target and associate each of these conditions with the appropriate
media query.
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When you generate the online output and view it on a large screen, the word “click” is
used.
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But when you view the output on a smaller tablet or mobile screen, the word “tap” is
used.

NOTE You can set responsive conditions on tables. However, if you also have a table
stylesheet applied to the table, responsive conditions only work if they are set on the entire
table (i.e., the <table> tag); they do not work if the conditions are set on individual rows,
columns, or cells.
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CHAPTER 6

Word Import Enhancements
Major enhancements have been made to the Word import interface, making the process easier and
more intuitive.

This chapter discusses the following:

Wizard Structure 49

General Page 51

Styles Page 53

Advanced Options Page 62
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Wizard Structure
Previously, the Word Import Wizard (File > New Project > MS Word Documents) was structured
much like other wizards in Flare, with Next and Back buttons that let you move through the pages.
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Now the wizard has just one required page (General) and two that are optional (Styles and
Advanced Options). This new structure makes it possible to complete the wizard more quickly after
setting the required options, as well as jump to either of the optional pages.
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General Page
The new General page combines the fields from the first couple of pages in the old wizard. You
must complete the fields on this page and select Word files before choosing one of the optional
pages or clicking Finish.
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There is also a new section that lets you import Word files into the open Flare project (if you open
the wizard by selecting Project > Import > MS Word Documents), as an alternative to creating a new
project. You can choose a folder to store the imported files; otherwise, Flare places them at the root
of the Content Explorer.

Finally, the option to link the imported files to the source Word documents has been moved to the
Advanced Options page.
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Styles Page
The new Styles page combines multiple pages from the old wizard into one. On this page, you can
do the following.

Associate a Stylesheet
You can choose an existing stylesheet by clicking . After doing this, styles from that stylesheet
become available in the drop-down fields below, so that you can map Word styles to those from the
stylesheet you chose.
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Discard and Restore Word Styles
By default, styles from the Word documents are mapped in such a way that their names are
retained and appended to Flare styles.

However, you can click Discard MS Word styles, which will map to the Flare style but not keep the
Word style name or its formatting.

If you change your mind, you can click Restore defaults, which will once again retain the Word style
names.

EXAMPLE

In your Word document, second-level headings use the “Heading 2” style. But in Flare, it
is named “h2.” So when the Word style is mapped to the Flare style, the resulting name
will be “h2.Heading2.”
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If you click Discard MS Word styles, the mapping remains in place, but now the res-
ulting name will be “h2” and any formatting from Word for that style is not retained.
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If you click Restore defaults, the mapping will once again result in the name “h2.Head-
ing2” and its formatting will be retained.
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Expand and Collapse Mapping Sections
The sections for mapping paragraph and character styles are included on the Styles page. And
since these sections can be somewhat lengthy, they can be expanded or collapsed as needed.

The following image shows both sections collapsed:
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And this image shows the Paragraph section expanded:
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Map Paragraph and Character Styles
To map a paragraph or character style from the Word documents to another style, use the drop-
down in that cell to select it. Flare styles are listed in the top part of the drop-down, while Word
styles are listed on the bottom.
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Choose Styles for Starting New Topics
If you want to specify that new topics should start with certain paragraph styles, click the check box
next to that style. The h1 style is selected by default (most authors start new topics on heading
styles), but you can choose any paragraph-level styles that you like.
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See a Preview
When you select a style row in either the Paragraph or Character section, a preview is shown at the
bottom so you can see how it looks. The design of the original Word style is shown on the left, and
the look of the mapped style is shown on the right.
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Advanced Options Page
The Advanced Options page has been reorganized and formatted, and includes:

n The same options found on the Options page of the old wizard

n Existing options moved from other parts of the old wizard

n Some new options

Following are explanations of the new options.
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Styles
n Create new stylesheet This creates a new stylesheet based on the settings you choose.

If you disable this option, the styles resulting from the import will be added to the project’s
master stylesheet.
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n [Inline formatting]

l Keep inline formatting This retains inline formatting found in the Word documents.

l Convert inline formatting to CSS styles This option is the same as previous versions,
where inline styles found in the Word documents are converted to CSS styles in Flare.
However, the other two formatting options in this drop-down are new.
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l Remove inline formatting This removes any inline formatting found in the Word doc-
uments, displaying it as regular text instead.
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Tables
n [Table styles]

l Create CSS table styles as regular stylesheet This finds table formatting in the Word doc-
uments and creates styles accordingly in the regular stylesheet in Flare. This is the
default behavior from previous versions of Flare.

l Convert table styles to Flare table styles This finds table formatting in the Word doc-
uments and creates a special table stylesheets accordingly in Flare.
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NOTE To use this feature, the table must have been created in Microsoft Word
2007 or later. Also, open the Options dialog (File > Options), select the General
tab, and make sure that Import/Export Word Files without MS Office is disabled.

l Apply a selected table stylesheet to all imported tables This lets you select an existing
Flare table stylesheet and apply it to all imported tables.

l Remove all table styles This removes styling from all tables found in the Word doc-
uments. You can keep them as plain tables in Flare or apply styles to them later.
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Lists
n Use standard list style type This will use standard bullets (e.g., square, disc) and numbering

(e.g., decimal), whether they were used in the Word documents or not.

If this is not enabled, lists are imported with the characters or symbols used for the lists in the
Word documents. However, these are contained within span tags in the Flare topics. This
allows you to keep special elements, (e.g., Wingdings) that you might have used in Word for
custom lists.

EXAMPLE

You have a Word document with lists, and it looks like this:
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If the option to use standard list style types is enabled, the topic in Flare will look
like this:
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If the option is disabled, the topic will look like this:
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Page Breaks
n Preserve and create new topics on page breaks This keeps any page breaks found in the Word

documents.

n Preserve and convert to MadCap page breaks This keeps any page breaks found in the Word
documents, but it will convert them to the special page break tags (MadCap|pageBreak) used
by Flare. This page break element displays as a gray bar in the XML Editor, but it is not shown
in the output; a page break simply occurs at that spot.

n Ignore page breaks This will not keep any page breaks found in the Word documents.
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CHAPTER 7

Additional Features
These are additional new features added to this release.

This chapter discusses the following:

Accessibility Enhancements 73

DOCX Default Word Output 86

Drag and Drop Files into Projects 87

FrameMaker 2019 Support 90

Git for Windows Integration 91

Zendesk Publishing Enhancements 94
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Accessibility Enhancements
The following accessibility enhancements have been made for HTML5 output.

Keyboard Navigation
The keyboard navigation experience has been improved for elements such asmenus, logos, and but-
tons.

n Borders In previous versions, it was not apparent which element had focus when you pressed
Tab in the output to move around. Starting with this version, a border shows each element
that has focus as you tab through them.
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n Enter/Space Buttons are considered elements that trigger an activity, but do not link to con-
tent. You can activate buttons by pressing either the Enter or Space key.
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n Search Elements You can tab through search fields elements, such as the input, filter, filter
drop-down, and submit button.
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n Submenus You can access submenus through the keyboard. If you press Tab on a menu item
that contains a submenu, a small drop-down arrow is temporarily shown.

If you press Enter, the submenu is shown.
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You can then continue to press Tab to move to each item.
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ARIA Tags
Multiple improvements have been made to support the Accessible Rich Internet Applications (ARIA)
technical specification from the World Wide Web Consortium. This includes the addition of tags
with information such as “described by” (tooltip), “role,” “label,” and more.

These changes affect the following elements:

n Breadcrumbs

n Drop-downs

n Expanding text

n Footnotes

n Glossary expanding text

n Glossary popups

n Logo

n Open Navigation button

n Popup text

n Pulse iframe
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n Search button

n Side Navigation menu

n Tablet and mobile menu

n Togglers

n Top Navigation menu

n Topic popups

n Topic toolbar buttons

n Tripane main structure

n Tripane navigation tabs
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Skip to Main Content
In previous versions, users working with a screen reader in HTML5 output would need to tab through
all the navigation items before arriving at the main topic or search results content.

Starting with this version, HTML5 outputs automatically include a “Skip to main content” option
when users open the output and press Tab. After encountering this option, they can press Enter to
bypass the navigation.

EXAMPLE

A user who is visually impaired opens your generated output and presses the Tab key.
The user is told that she can skip to the main content.
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After pressing Enter on the keyboard, the user’s experience is that focusmoves imme-
diately to the topic content instead of first moving through the logo, menus, and any
other skin navigation items.
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Changing UI Text
You can use the UI Text tab in the Skin Editor or a language skin to change the text for several new
elements related to accessibility, such as the logo tooltip and “Skip to Content” label.

SIDE AND TOP NAVIGATION SKINS
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TRIPANE SKINS
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DOCX Default Word Output
A new field in the Target Editor for Word targets lets you choose the Word format—either DOCX
(default) or DOC.

Previously, the only way to create Word output in DOCX format was to add the extension to the file
name in the target. However, this generated Word DOCX in compatibility mode.

With this new option, the output will be in true DOCX format, rather than compatibility mode.

NOTE If you have existing Word targets, Flare will preserve your settings. Therefore, if you
want to use the new DOCX format, you need to select it from the new field.
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Drag and Drop Files into Projects
You can drag all kinds of files from Windows into a Flare project, thus making those files part of the
project. Copying and pasting the files (instead of drag-and-drop) works the same way.
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Guidelines
n You can drag files into both the Content Explorer and Project Organizer.

l The Content Explorer accepts just about any type of file, except those that belong in the
Project Organizer (e.g., condition tag sets, glossaries, skins, targets).

l The Project Organizer accepts only files that can be added to it from within Flare. You
cannot drag topics or other kinds of content files into the Project Organizer.

n If you drag files into the Content Explorer, and those files file types have an import process in
Flare (e.g., Word, FrameMaker, HTM), a dialog asks if you want to import or copy the files into
the project.

l If you select to copy a file, it is simply added to the project.

l If you select to import a file, the appropriate wizard opens. This lets you choose additional
options regarding how the file is brought into Flare.

After finishing the import process, a new import file will be created and added to the Pro-
ject Organizer as a result.
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n If you drag a file type that does not have an import process in Flare, the file is simply copied
into the project.

n If you drag files of different types at the same time, Flare copies them without the option to
import. If you want to import the files, you must drag those of the same type independently.

n If you drag a folder containing files, Flare copies them without the option to import.

n If the project is bound to source control, files added will be in a pending add state.

n If you drag a file (except FLPRJ or FLPRJZIP) into Flare when no project is open, you will see a
dialog that lets you choose a project.

After you select a project, the project opens and the file is copied into it.

If you drag an FLPRJ or FLPRJZIP file to the title bar in an empty session of Flare, it will work
as it has in the past; the project is loaded or a dialog lets you unpack the zip file.
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FrameMaker 2019 Support
Flare now supports FrameMaker 2019 for file imports.

CHAPTER 7  90



Git for Windows Integration
In Windows 10 version 1903, Microsoft implemented OpenSSH, which is the open-source version of
Secure Shell (SSH). As a result, a project bound to Git using SSH as the transfer protocol might
experience error messages (e.g., failed to start SSH session). The solution is to download and install
Git for Windows (Git.exe).

An upside to installing Git.exe is that it is likely to result in faster and better performance for file
transfers.

HOW TO DOWNLOAD AND INSTALL GIT.EXE

1. Select File > Options.

2. Select the Source Control tab.

3. Click Get Git for Windows. A page opens on your browser, and the download should begin auto-
matically.
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NOTE If you already have Git.exe installed, but not the latest version, this link will
instead display “Get an updated version of Git for Windows.”

4. When the download finishes, open it.

5. Follow the steps in the wizard. We recommend you keep the default selections.
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6. After you click Install and the installation completes, click Finish.

After a few moments, the link in the Flare Options dialog should go away and you should see
this instead:

7. Click OK.

NOTE If you have Git.exe installed, it will be used for network functions, whether you have
selected HTTPS or SSH as the MadCap Central transfer protocol in the Options dialog.
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Zendesk Publishing Enhancements
The following enhancements have been made to the Zendesk Publishing process in Flare.

Publish to Alternate Brands
You can now publish to alternate brands in a multi-brand account, whereas previously you were lim-
ited to just the default subdomain.

EXAMPLE

In Zendesk you have a subdomain called “MadCap Software,” the name of your com-
pany.

Instead of publishing everything to that subdomain, you want to publish specific con-
tent to each or your company’s products: Product A, Product B, and Product C. There-
fore, you create brands for each of those products.
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In Flare, you have a target, destination file, and TOC dedicated to Product A. The target
points to both that destination file and the TOC.
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When you enter your credentials in the Destination Editor, you provide the URL for that
brand.
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After you publish the target, the content for Product A displays within the Product A
brand on Zendesk.
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New Content Options
The following options have been added to the Content options section of the Destination Editor
when you have MadCap Connect for Zendesk selected as the type:

n User visibility Select a group of users on Zendesk who are allowed to view published content.
The selections available in this drop-down correspond to those that have been set up on
Zendesk.

n Management permissions Select a group of users on Zendesk who are allowed to edit and
publish content. The selections available in this drop-down correspond to those that have
been set up on Zendesk. Administrators and Team Leaders are always included and cannot
be removed.

n Delete stale labels Select this if you want outdated labels to be deleted from Zendesk auto-
matically.

EXAMPLE

If you have enabled the option to Use keywords for labels, and then you delete a
keyword in the Flare project, that corresponding label will be removed when you
re-publish to Zendesk.
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CHAPTER 8

Deprecated Features
Following are features that will be removed in the next release of MadCap Flare, alongside features
that we recommend as replacements. For more information on the replacements, see the Flare
online Help.

Deprecated Features Recommended Replacements

DITA Output Clean XHTML or HTML5 Output

Toolstrip Ribbons

WebHelp and WebHelp Plus HTML5 Output

To provide feedback on these deprecated lists, please send an email to:

supportplanrep@madcapsoftware.com
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APPENDIX

PDFs
The following PDFs are available for download from the online Help.

TUTORIALS

Getting Started Tutorial

Product Foldout Tutorial

Side Navigation Tutorial

Top Navigation Tutorial

USER GUIDES

Accessibility Guide HTML Help Guide

Analysis and Reports Guide HTML5 Guide

Architecture Guide Images Guide

Autonumbers Guide Importing Guide

Condition Tags Guide Indexing Guide

Context-Sensitive Help Guide Key Features Guide

Eclipse Help Guide Language Support Guide

Getting Started Guide MadCap Central Integration Guide

Global Project Linking Guide Master Pages Guide

APPENDIX  103



Micro Content Guide Source Control Guide: Perforce

Movies Guide Source Control Guide: Subversion

Navigation Links Guide Source Control Guide: Team Foundation Server

Plug-In API Guide Styles Guide

Print-Based Output Guide Tables Guide

Project Creation Guide Tables of Contents Guide

QR Codes Guide Targets Guide

Reports Guide Templates Guide

Reviews & Contributions Guide Topics Guide

Search Guide Touring the Workspace Guide

SharePoint Guide Transition From FrameMaker Guide

Skins Guide Variables Guide

Snippets Guide What's New Guide

Source Control Guide: Git

CHEAT SHEETS

Folders and Files Cheat Sheet

Print-Based Output Cheat Sheet

Shortcuts Cheat Sheet

Structure Bars Cheat Sheet

Styles Cheat Sheet
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